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1. Introduction 
 
S3GRAF v9.1 is the latest version of the Reservoir Engineering Visualisation software from 
Sciencesoft Ltd. S3GRAF provides functionality to quickly and efficiently visualise and analyse 
reservoir simulation data from a range of simulators. Line plots of well production data (for 
example) and views of the simulation grid can be created. With the 3D module three-
dimensional displays of simulation grid data can be generated. The HPG module permits 
extremely fast loading of grid geometry and vector data, especially for large datasets. 
 
The new features to be found in the latest version of S3GRAF are outlined as follows: 
 

Workflow Manager 
The Workflow Manager is a new way of using the power of S3GRAF for plotting, creating new 
quantities and performing analyses. Workflows capture a standard reservoir engineering task 
and allows it to be recreated quickly and easily from the Workflow Manager. 
 
The Workflow Manager presents all the included workflows in an easily navigable list that can 
then be selected for application. The user can then set the relevant properties, based on the 
loaded data, to produce the analyses and information required. 
 
Help Portal: http://support.sciencesoft.com/hc/en-us/articles/207518436  
 

New User Functions 
New functions have been made available for the User Functions feature of the Derived 
Quantities. These are: 
 

o CUMMAX Cumulative Maximum 
o CUMMIN Cumulative Minimum 
o DELTA  Difference across timestep 

 

Create RFT Data Based on Solution Data Perforation Locations 
Pseudo-RFT data can now be created from Solution and Grid data, based on the location of 
Completions contained in the Solution datasets. Previously this required a separate trajectory 
file and used actual MD values. 
 
Help Portal: http://support.sciencesoft.com/hc/en-us/articles/205705245 
 

New Statistic Calculations and Export Option 
A set of calculations to produce the P90, P50 and P10 for a set of vectors has been made 
available for the Statistics tool. These quickly provide a quick representation of the statistical 
significance of a number of runs. 
 
A new option for exporting calculated statistics vectors to the treeview has also been added 
to the Statistics tool. 
 
Help Portal: http://support.sciencesoft.com/hc/en-us/articles/205019649  
 

http://support.sciencesoft.com/hc/en-us/articles/207518436
http://support.sciencesoft.com/hc/en-us/articles/205705245
http://support.sciencesoft.com/hc/en-us/articles/205019649
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Layer Analysis GRF Commands 
New GRF commands have been added to simplify the creation of a Layer Analysis. These new 
commands are executed with the use of an ALL keyword for layers and timesteps. 
 

Improved Eclipse H5 File Support 
Support has been improved for 2013 and 2014 versions of the Eclipse H5 file format for 
Summary data. This file allows Fetch on Demand to be used for Summary data. 
 

VIP/Nexus ALIAS File Support Extended 
The ALIAS file in VIP/Nexus allows wellnames longer than eight characters. The ALIAS/Alias 
xref file can now be applied to members within the map data for VDBs and for MAP files as 
well as for PLT files. 
 

UTCHEM/UTCOMP Corner Point Grid Support 
Support has been added for corner point grid formats in UTCHEM/UTCOMP. 
 

UTCHEM Format Load Commands for GRF 
The GRF language has now been extended to include the option to define the timestep format 
for Solution data. This allows the data to be organised by Time, Pore Volume or a combined 
Time & Pore Volume. There is also now an option to define the default x-axis for Summary 
data, this can be either Time or Pore Volume. 
 

RFT Layer Lines 
Formation depth lines can be added to RFT plots as an alternative to standard depth lines. 
Formations can be defined with a LYR file and loaded into S3GRAF. These allow quick 
identification of formations while examining well data with a RFT plot. 
 
Help Portal: http://support.sciencesoft.com/hc/en-us/articles/207702626 
 

Graph Search with Completions Indices 
When using Graph Search, individual I, J and K values for the Completion data can be used to 
define the search. For instance, by defining a specific K, oil output from a defined formation 
can now be plotted (for all wells completed in that formation). 
 
Help Portal: http://support.sciencesoft.com/hc/en-us/articles/205735105   
 

Multi-Phase Injector Support 
Support for the display of multi-phase injector wells has been added. 
 
  

http://support.sciencesoft.com/hc/en-us/articles/207702626
http://support.sciencesoft.com/hc/en-us/articles/205735105
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Alternative Ternary Colour Scheme 
A new Ternary Plot colour scheme has been added to allow for differing conventions. This is a 
system setting and so can be changed permanently in S3GRAF. 
 
The colour scheme for Ternary Plots can be toggled between: 
 

Phase Default Scheme Alternate Scheme 

Oil Green Red 

Water Blue Blue 

Gas Red Green 
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2. Workflow Manager 
 
The Workflow Manager is a new way of using the power of S3GRAF for plotting, creating new 
quantities and performing analyses. Workflows capture a standard reservoir engineering task 
and allows it to be recreated quickly and easily from the Workflow Manager. 
 
The Workflow Manager presents all the included workflows in a list that can then be selected 
for application. The user will then set the relevant properties, based on the loaded data, to 
produce the analyses and information required. 
 
Workflows are based on modified GRF files, however the user does not need to understand 
the GRF script. Instead the user is presented with a description of the workflow's actions and 
a list of user-definable parameters, usually data dependant, which are then set before the 
workflow is executed. 
 

2.1. Accessing the Workflows 
 
Once any data set has been loaded into the Treeview, the Workflow Manager tool will be 
enabled. This can be accessed from the Tools menu, as seen in Figure 1, or from the Derived 
Quantities toolbar. 
 

 
Figure 1 - Menu Access for Workflow Manager 

 
Click on the Workflow Manager item and the Workflow Manager dialog will appear, as seen 
in Figure 2. 
 
The presented workflows are dependent upon what data has been loaded into S3GRAF, i.e. if 
only Eclipse data sets are loaded then only the Eclipse specific Workflows are listed. This 
filtering can be changed by selection from the Type drop-down list, and can be refined further 
by specifying a filter using the Filter textbox and standard wildcards (*, ?, partial names, etc.). 
 
The dialog will contain a list of valid Workflows that can then be applied to the loaded data. 
Double-clicking on a workflow or clicking the Next while a workflow is highlighted will then 
open a dialog for the chosen workflow where the necessary parameters can be set before 
execution. 
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Figure 2 - Workflow Manager Dialog 

 

2.2. Running a Workflow 
 
The procedure for running a Workflow can be summarised as follows: 
 

1. Load the data set upon which to perform the Workflow.  
2. Open the Workflow Manager.  
3. Select the Workflow to perform.  
4. Set the required parameter values for the analysis.  
5. Run the Workflow.  
6. Examine the created plots and new items in the Treeview. 

 

Workflow Selection 
 
Once the Workflow Manager has been opened select a workflow from the list and click Next. 
 
Each Workflow is accompanied by an article on the Sciencesoft Help Portal. This article will 
provide extra detail on the construction and use of the Workflow. Double-clicking on the last 
column will open the corresponding article in a browser. A registered Sciencesoft account is 
necessary to access the portal. 
 
In this example the Generate Oil Map has been selected. 
 

http://support.sciencesoft.com/hc
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Figure 3 - Selecting a Workflow 

 

Workflow Setup 
 
The details for the chosen Workflow will then be presented, see Figure 4. This dialog will show 
more information on the Workflow including what data may be required, what calculations 
are performed and what the output will be. 
 
This dialog details what information is required from the user and lists the parameters that 
need values to be set, such as well names or property values. Default values are presented but 
in most cases will be unsuitable for the chosen data set and are usually highly specific to the 
properties of the data set. 
 
The data set origin will be automatically allocated from the first case in the Origin list. 
 
If there are multiple data sets loaded, the origin can be selected from the Select Origin drop-
down list, or typed in to the Case name parameter directly, as seen in Figure 5. 
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Figure 4 – Workflow Launch Dialog 

 

 
Figure 5 - Setting a Workflow Case Name 
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Parameter Definitions 
 
A Workflow may depend upon a number of values to be set by the user, such as values for 
Rock Quality (RQ) in the example. These are presented in a list below the description of the 
Workflow. All of the items should be changed to suit the selected data before running the 
Workflow. 
 
Double-clicking on any of the rows produces a dialog to change the item value, see Figure 6. 
 

 
Figure 6 - Setting a Workflow Parameter 

 

Running the Workflow 
 
Once satisfied with the values, click the Run button. Behind the scenes the system will create 
a temporary GRF to apply the workflow procedure and automatically load it into S3GRAF. If 
the Workflow completes successfully, the normal GRF message will be displayed, see Figure 7. 
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Figure 7 - Successful Workflow Application Message 

Any new data sets will appear in the Treeview and any plots or grids will be added to the Graph 
List (and displayed if the Display Graphs immediately after import is on). 
 
If there is an error a warning message, see Figure 8, will appear inviting the user to investigate 
the GRF reader report file. This can then be used to debug any issues recreating the Workflow. 
 

 
Figure 8 - Unsuccessful Workflow Application Message 

 

2.3. Importing a New Workflow 
 
New workflows may be supplied through Sciencesoft’s support desk and these can be 
imported into S3GRAF. To do this open the Workflow Manager and click on the Add Workflow 
button at the bottom of the dialog. A file open dialog will be presented so select the file to be 
added and click OK in the usual manner. 
 
Alternatively the Workflow file can be dragged-and-dropped onto the Workflow Manager 
dialog to add it to the list. 
 
If it is a valid Workflow file it will be added to the system and a message confirming the addition 
presented, see Figure 9, clicking OK and it will be added to the list for use. 
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Figure 9 - Workflow Addition Confirmation Message 

 

2.4. Notes on Workflows 
 
A range of common Workflows have been provided as part of the S3GRAF installation and have 
been created by the Sciencesoft support team. Other Workflows will be added in future and 
as part of our support system. If a customer requires a new workflow, this can be provided on 
demand. Please email support@sciencesoft.com. 
 

2.5. Help Centre linkage 
 
Further details on individual Workflows can be found on the Sciencesoft Help Portal. Each 
Workflow presented in the Workflow Manager list has a direct link to the Portal for an article 
describing, in detail, the workflow performed. 
 
A registered Sciencesoft account is necessary to access the Portal. 
 

  

mailto:support@sciencesoft.com
http://support.sciencesoft.com/hc
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3. New Analysis Features 

3.1. New User Functions 
 
There are three new mathematical functions that can be used within the User Function tool. 
This is launched from User Function item in the Derived Quantities sub-menu of the Tools menu 
or the corresponding toolbar button. 
 
These functions are summarised as follows: 
 

CUMMAX - Cumulative Maximum 
 
This function calculates the cumulative maximum of each element of a map vector (grid cell) 
through time, i.e. for element n of the given vector, the cumulative maximum is the maximum 
value of n occurring 1 through t (where t is the current timestep). 
 
This is invoked in the User Function as: 
 
 Y=CUMMAX(A) 

 
Where Y is the output vector and A is the grid Solution property. For example, if A was 

PRESSURE from the 5th timestep the output Y would be the maximum PRESSURE for each cell 
over the 1st to 5th timestep period but not including anything beyond the 5th timestep. 
  

CUMMIN - Cumulative Minimum 
 
This function calculates the cumulative minimum of each element of a map vector (grid cell) 
through time, i.e. for element n of the given vector, the cumulative minimum is the minimum 
value of n occurring 1 through t (where t is the current timestep).  
 
This is invoked in the User Function as: 
 
 Y=CUMMIN(A) 

 
Where Y is the output vector and A is the grid Solution property. For example, if A was 

PRESSURE from the 5th timestep the output Y would be the minimum PRESSURE for each cell 
over the 1st to 5th timestep period but not including anything beyond the 5th timestep. 
 

DELTA - Difference across timestep 
 
This function calculates the difference for each map vector element between the current 
timestep (t) and the previous timestep (t-1), i.e. show the value changes for the current step.   
 
This is invoked in the User Function as: 
 
 Y=DELTA(A) 

 
Where Y is the output vector and A is the grid Solution property. For example, if A was 

PRESSURE from the 5th timestep the output Y would be the PRESSURE change for each cell 
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between the 5th and the 4th timesteps. If A is the first timestep then the output Y is set to zero 
for all cells. 
 

3.2. Create RFT Data Based in Solution Data Perforation Locations 
 
The Standard Function feature includes the Create RFT Data function that produces RFT data 
based on a wellbore path as defined by a trajectory file. When this is unavailable the path of 
the well can instead be approximated from the completion/perforation locations contained in 
the Solution data sets and pseudo-RFT data created. 
 
The Standard Function feature is accessed from the Standard Function item in the Tools -> 
Derived Quantities menu or the corresponding toolbar button. The Create RFT Data option can 
then be selected from the drop-down function selection of the dialog shown in Figure 10. 
 

 
Figure 10 - Standard Function Dialog for Create RFT Data 

 
To perform the calculation based on the Solution select USE SOLUTION MARKERS from the 
Trajectory drop-down, circled in red in Figure 10. 
 

Calculation Methodology 
 
This option will take the cell values for the Solution and INIT vectors at the location of the well 
completions/perforations and export them to a new RFT data set in the treeview. 
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Due to the limitations of the data available only an estimate of the Measured Depth (MD) is 
made. This is based on a calculation of the direct distance between the cell centres for each 
successive completion/perforation cell location. The depth of the first completion/perforation 
is used to set the initial MD then the calculated distance between the first and second 
completion/perforation is added to this to define the MD of the second 
completion/perforation. This is repeated for each successive completion/perforation. 
 

3.3. New Statistics Calculations and Export Option 
 
Calculations to produce the P90, P50 and P10 for a set of vectors have been made available 
for the Statistics tool. These can quickly provide a representation of the statistical significance 
of a number of runs. The option to export the calculations from the Statistics tool has also 
been made available to allow the new data to be further analysed. 
 
The Statistics dialog is accessed from the Tools menu by clicking on the Statistics item. The 
new calculations can be selected from the drop-down list, circled in red in Figure 11. 
 

 
Figure 11 - Statistics Dialog 

 

P90, P50 and P10 
 
Added to the list of statistics to display on the graph is P90 P50 P10. These calculations produce 
the P90 (proven), P50 (probable) and P10 (possible) as a probability analysis for the chosen 
data vectors as a measurement of distribution between them. 
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In practice this will take the vector list defined in the Statistics dialog and extract the values 
for each vector at the final timestep of the reference time base. These values are ordered to 
produce a percentile ranking and the closest matches for the P90, P50 and P10 found. The P90 
is defined as the proven result (with an estimated 90% chance of final vector values exceeding 
this), P50 is the probable result (analogous to the median) and P10 is known as the possible 
result (estimated 10% exceeding this). 
 
This method is intended for analysing oil production totals from multiple runs to generate the 
most common definition of P90, P50 and P10. However, the technique can be applied to any 
list of vectors. 
 
Each calculation can be applied individually by selecting the relevant checkboxes. 
 

Export Option 
 
Any of the calculations that can be performed from the Statistics dialog can now be exported 
to the Treeview where they can be examined further. When the relevant settings are chosen 
for the statistical calculation the user can click on the Export button on the Statistics dialog to 
output the data to the Treeview where it will be listed as a new data set and suitably named. 
 

3.4. Layer Analysis GRF Commands 
 
There are now GRF commands to simplify the reproduction of Layer Analysis from GRF. For 
Layer Sum, Layer Average and Layer Sample commands the layer range that the analysis 

operates over can be simplified from OVER <top_layer> TO <bottom_layer> to 
OVER ALL when including all the layers. 
 
Further, when performing a Layer Analysis over all timesteps, instead of repeating the GRF 
command for each timestep individually a single GRF command can be used by specifying 
STEP ALL rather than STEP 1, etc. 
 
This shorthand is invoked as necessary when creating a GRF after performing a Layer Analysis 
by hand. 
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4. New File/Loading Support 

4.1. Improved H5 File Support 
 
Support has been improved for 2013 and 2014 versions of the Eclipse H5 file format for 
Summary data. This file allows Fetch on Demand, as part of the HPG module, to be used for 
Summary data. This enables faster loading and smaller memory footprints. 
 

4.2. VIP/Nexus Alias File Support Extended 
 
The ALIAS file in VIP/Nexus simulations allow class member names longer than eight 
characters. The ALIAS files are used as a lookup to match the defaulted member name with 
the defined long name. 
 
For VDBs the ALIAS.bin file details the lookup and these are used for both the loaded Plot data 
and the wells shown on grid displays. All references to the member names in S3GRAF will be 
replaced with the long names. Their use is controlled from the load dialog by checking the Use 
long well names (Nexus) as seen circled in red in Figure 12. 
 

 
Figure 12 - VDB load dialog 

 
For MAP and PLT files the Alias_names.xref file is used to lookup the long member names for 
the various data classes. These are also used for the loaded Plot data and the well names when 
displaying a grid. Their use is also controlled from the load dialog by checking the Use long well 
names from xref file as shown circled in red in Figure 13. 
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Figure 13 - Load dialogs for MAP and PLT files 

 
For example, in the ALIAS_names_xref file the WELLS might be names as: 
 
WELLS 

 

SHORT  LONG 

-----  ---- 

WEL00001 WELL1_PRODUCER 

WEL00002 WELL2_INJECTOR 

… 

 
So associated map data will use WELL1_PRODUCER, etc., to label the wells on the grid display 
and to name the well as such in the Treeview and line plots. 
 

4.3. UTCHEM/UTCOMP Corner Point Grid Support 
 
Support has been added for corner point grid formats in UTCHEM/UTCOMP. This is handled 
automatically and should be transparent to the user. 
 

4.4. UTCHEM Format Load Command for GRF 
 
The GRF language has now been extended to include the option to define the timestep format 
for Solution data. This allows the data to be organised by Time, Pore Volume or a combined 
Time & Pore Volume. There is also now an option to define the default x-axis for Summary 
data, this can be either Time or Pore Volume. 
 
For Solution data the organisation of the data can be in Time, Pore Volume or Time and Pore 
Volume. The GRF load command to load the solution data is: 
 
LOAD UTCHEM FORMAT <format> SOLUTION <filename> 
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Where the <format> entry is either: 
 

Keyword Solution timestep definition 
PV Defined by injected Pore Volume 
TIME Defined by Time  
TIMEPV Defined by Time and injected Pore Volume 

Table 1 - UTCHEM Load Format Commands for Solution Data 

For Summary data the default x-axis vector can be Time or Pore Volume and the FORMAT 
keyword is used  
 
LOAD UTCHEM FORMAT <format> SUMMARY <filename>  
 
Where the <format> entry is either: 
 

Keyword Default Summary X-Axis 
PV Defined as injected Pore Volume (PV) 
TIME Defined by Time (TIME) 

Table 2 - UTCHEM Load Format Commands for Summary Data 

The default option for Solution data is to use Time and for Summary data it is Pore Volume. 
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5. New Line Plot Features 

5.1. RFT Layer Lines 
 
Formation depth lines can be added to RFT plots as an alternative to standard depth lines. 
Formations can be defined with a LYR file and loaded into S3GRAF. These allow quick 
identification of formations while examining well data with a RFT plot. 
 
LYR files contain data required to produce RFT formations lines. They consist of a list of 
formation names and the layer range that constitutes a formation. These definitions are then 
used for formation layer lines as representations of the approximate depth boundaries 
between formations in RFT plots. 
 
LYR files can be loaded in the normal manner, either dragged-and-dropped onto S3GRAF or 
through File -> Open. Once loaded an LYR file will appear in the Treeview under an origin 
defined by the file name and in a folder labelled "LYR". It is intended that a LYR file should have 
the same filename as the accompanying RFT file. 
 

LYR File Example 
 
The LYR file consists of a list of formation names with their upper and lower layer indices. It 
can be created by Eclipse or by hand in a text editor. 
 
The below .LYR file example shows four sand formations stretching over grid layers (z-
direction). Each formation is defined with a name, bracketed with single quotes, and an upper 
and lower layer index, separated by a dash (-). 
 

'SAND_1' 1 - 3 

'SAND_2' 4 - 5 

'SAND_3' 6 - 8 

'SAND_4' 9 - 11 
 
 
e.g. SAND_1 - Stretches over layer k=1 to layer k=3. 
 

RFT Plots and Layers 
 
Once a RFT plot has been produced the RFT layers can be added with the Show RFT Layers 
toggle button, seen in Figure 14. When a LYR file has been loaded within the current Origin. 
 

 
Figure 14 - RFT Layers Button 

Whereas standard depth lines represent the cell centred depths at each completion, formation 
layer lines from the LYR file represent the approximate depth boundaries between specified 
groups of layers. This is estimated by comparing the layer indices of the formations to 
perforation indices and their corresponding depths for the displayed RFT line. 
 
The Figure 15 shows the Pressure down a well as it traverses formations SAND_1 to SAND_3. 
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Figure 15 - Example Display of RFT Layers 

 
 

5.2. Graph Search with Completion Indices 
 
When using Graph Search, individual I, J and K values for the Completion data can be used to 
define the search. For instance, by specifying different K, oil output from a defined formation 
can now be plotted (for all wells completed in that formation). 
 
 
In S3GRAF it is possible to create a graph containing multiple lines quickly using the Graph 
Search facility. This feature will search for all lines matching a pre-set criteria and then place 
the lines onto either an existing or a new graph. S3GRAF can now process an Index field in the 
Graph Search to allow for searching on a grid layer (or in the I- or J-direction). 
 
The Graph Search facility can be found under the Graph menu. When it is selected the dialog 
shown in Figure 16 will appear. 
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Figure 16 - Graph Search Functionality 

 
Clicking on the ">>>" button at the top of the dialog will allow the selection of the vectors to 
add to the graph. Dropping a data vector that includes an index or cell location and performing 
a Search and Add will populate the vector list with the corresponding vector properties, 
including any index or cell indices. An example is shown in Figure 17. 
 

 
Figure 17 - Graph Search Vector Search 

 
Each property of the vector (Member, Class, Type, I, J, K) can be used in a Graph Search. Ticking 
a box sets the search to match on that property.  
 
In the example above, Member (i.e. Well) is unchecked and can take any value - not just well 
B1. This means all wells will be included in the search. The search is for Completions Summary 
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data from BASE1 (all checked). I and J can take any value (unchecked). What must match is 
that the Completions are in layer 1 (K=1 is checked). 
 
After pressing Search and add the Graph Search finds four wells (B1,B2,B3,B4) completed in 
layer K=1, with I,J values of (3,15) (3,19) (3,10) (6,22). 
 
Clicking OK will return to the Graph Search dialog, now filled with the list of selected vectors, 
shown in Figure 18. 
 

 
Figure 18 - Filled Graph Search Dialog 

 
Dragging and dropping the icon highlighted in red onto the Display Area will produce a plot 
containing all the selected vectors. 
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6. New Grid Features 

6.1. Multi-Phase Injector Support 
 
Support for the display of Oil injector and Multi-Phase injector wells has been added. These 
will be interpreted from the loaded data and he appropriate symbols used. Examples for the 
new symbols for Multi-Phase injectors are shown in Figure 19 and Figure 20. 
 

 
Figure 19 - Multi-Phase Injector 2D 

 

 
Figure 20 - Multi-Phase Injector 3D 

 
Examples of the new symbols for Oil injectors are shown in Figure 21 and Figure 22. 
 
 

 
Figure 21 - Oil Injector 2D 
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Figure 22 - Oil Injector 3D 

 

6.2. Alternative Ternary Colour Scheme 
 
A new Ternary Plot colour scheme has been added to allow for differing conventions. This is a 
system setting and so can be changed permanently in S3GRAF. The colour scheme for Ternary 
Plots can be toggled between the Default and Alternate scheme as defined in Table 3. 
 

Phase Default Scheme Alternate Scheme 

Oil Green Red 

Water Blue Blue 

Gas Red Green 
Table 3 - Ternary Colour Schemes 

 
The global option can be set from the S3GRAF Options dialog, which is accessed by clicking on 
the Tools menu and selecting Options… and finally clicking on the Grid tab. This will present 
the options as seen in Figure 23, the option is set from Default to Alternative by checking the 
Alternative Ternary Colours checkbox, seen circled in red. 
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Figure 23 - S3GRAF Options dialog, Grid Settings 

 

 


